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About Grove

Grove is a modular, plug-n-play technology platform developed by SeeedStudio. Much
like Lego, it takes a building block approach and applies it to assembling electronics.
The Grove system consists of a base shield and various modules and sensors with
standardized connectors. The base shield allows you to easily connect any microproce-
ssor input or output from the Grove modules, each with their own function. Grove
modules and sensors range from simple buttons to complex heart rate sensors. Each
one comes with clear documentation and demo code to help you get started quickly.

About GrovePi+

GrovePi+ enables you to use Grove sensors with the Raspberry Pi. GrovePi+ is
compatible with the Raspberry Pi model B, B+, A+ and 2. The GrovePi+ was designed
& developed by an American robotics education company, Dexter Industries.

About SeeedStudio

Seeed is the leading open source hardware innovation platform for makers and
inventors to grow their inspirations into unique products. Working closely with our
technology partners, Seeed's in-house engineers, supply chain managers and agile
manufacturing plant enables us to produce anywhere from 1 to 1,000 pcs with high
quality & speed, at a competitive cost.

www.seeed.cc

About Dexter Industries

Dexter Industries is an American educational robotics company that designs &
develops robot kits to make learning how to program accessible & fun for everyone.
Other kits include the GoPiGo & BrickPi & Arduberry

www.dexterindustries.com

Questions & Support
Documentation, support material, and example projects can be found on our website:
www.dexterindustries.com/GrovePi

Technology support forums & contact information:
www.seeedstudio.com/forum
www.dexterindustries.com/forum/?forum=grovepi

GrovePi+

Product information, specifications, documentation, and example projects:
www.seeed.cc/grovepi

www.dexterindustries.com/GrovePi

Open source software resources:
https://github.com/Dexterlnd/GrovePi
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What have we got here?

This is a simple yet enjoyable twig to use. The piezo can be
connected to digital outputs, and will emit a tone when the output
is high. Alternatively it can be connected to an analog pulse-width
modulation output to generate various tones and effects.

How to work:

One digital input pin.

More details:
http://www.seeedstudio.com/depot/Grove-Buzzer-p-768.html

Grove - Buzzer

Grove - Button What have we got here?

This product is a momentary push button. It contains one
independent "momentary on/off" button. “Momentary” means that
the button rebounds on its own after it is released. The button
outputs a HIGH signal when pressed, and LOW when released.
How to work:

One input

More details:
http://www.seeedstudio.com/depot/Grove-Button-p-766.html

What have we got here?
Grove - Red LED This is a Red LED designed to monitor controls from digital ports. It
can easily be mounted to the surface of a box or desk to be used as
a pilot lamp for power or signal. Its brightness can be adjusted by
the knob on the sensor.
How to work:
One digital input pin
More details:
http://www.seeedstudio.com/depot/Grove-Red-LED-p-1142.html

N
What have we got here?

Grove - Green LED This is a Green LED designed to monitor controls from digital ports.

It can easily be mounted to the surface of a box or desk to be used

as a pilot lamp for power or signal. Its brightness can be adjusted by

the knob on the sensor.

How to work:

One digital input pin

More details:

http://www.seeedstudio.com/depot/Grove-Green-LED-p-1144.html )




Grove - Blue LED

What have we got here?

This is a Blue LED designed to monitor controls from digital ports. It
can easily be mounted to the surface of a box or desk to be used as
a pilot lamp for power or signal. Its brightness can be adjusted by
the knob on the sensor.

How to work:

One digital input pin

More details:
http://www.seeedstudio.com/depot/Grove-Blue-LED-p-1139.html

Grove - Sound Sensor

What have we got here?

The Sound sensor module is a simple microphone. It can be used to
detect the sound strength of the environment. The resistance of the
sensor decreases when the sound intensity of the environment
increases. The value of the output can be adjusted by the knob on
the sensor.

How to work :

One analog output pin.

More details:
http://www.seeedstudio.com/depot/Grove-Sound-Sensor-p-752.ht
ml

The Relay is a digital switch that is capable of switching much
higher voltages and currents than the normal Launchpad boards.
The default is for the relay to be in the open position. When set to
HIGH, the LED will light up and the relay will close to allow currents
to flow. The peak voltage capability is 250V at 10 amps.

How to work:

One digital input pin.

More details:
http://www.seeedstudio.com/depot/Grove-Relay-p-769.html

Grove - Ultrasonic
Ranger Sensor

What have we got here?

This Grove Ultrasonic sensor detects distance through ultrasonic
technology, so it doesn’t need to touch an object to detect that it is
there.

How to work:

One digital output pin.

More details:
http://www.seeedstudio.com/depot/BackorderGrove-Ultrason-
ic-Ranger-p-960.html?cPath=25_31

What have we got here? }




Grove - Temperature What have we got here?

Humidity Sensor This sensor measures temperature and humidity of the
environment. IT consists of a capacitive sensor element used for
measuring relative humidity and a negative temperature coefficient
(NTC) thermistor used for measuring temperature.

How to work:

One analog input pin

More details:
http://www.seeedstudio.com/depot/Grove-TemperatureHumidity-
Sensor-Pro-p-838.html?cPath=25_125

What have we got here?

This is a knob that you can turn to control how much voltage is
Grove - delivered to a pin on the GrovePi+ board. You can write a program
for the GrovePi+ telling it how to use that measurement to control
how much voltage is being delivered to another sensor connected
to the board. A classic example is to use this knob to increase or
decrease the voltage sent to a LED to make it brighter or dimmer.
More specifically, this variable resistor produces an analog output
between 0 and Vcc (total voltage coming through the D1 connector
on the GrovePi+ board) as it turns. It can rotate up to 300 degrees
with a linear change in value and is a simple way to increase or
decrease the amount of voltage passing through it.
How to work:
One analog input pin
More details:
http://www.seeedstudio.com/depot/Grove-Rotary-Angle-Sen-
sor-p-770.html?cPath=85_52

Rotary Angle Sensor

What have we got here?

The Grove - Light Sensor v1.2 is updated version of Grove - Light
Grove - Light Sensor Sensor 1.0 which is aimed at measuring light levels. It is an analog
module and output various electrical signals which can be
converted to different ranges (that depends on the Analog-to-Digi-
tal-Converter on your controller board. For example, it will output
0-255 for an 8-bit ADQ). It integrates a high-sensitive and reliable
photoresistor, and is interfaced with Grove port which will save you
a lot of work in the wiring. This module can be used in various
smart-lighting device or facilities.
How to work:
One analog input pin
More details:
http://www.seeedstudio.com/wiki/Grove_-_Light_Sensor_v1.2




What have we got here?

This screen can be programed to display any color or character you
want. Want to display a shape or your name? You can design it to
show anything that you can think of.

How to work:

12C Connector

More details:
http://www.seeedstudio.com/depot/Grove-LCD-RGB-Back-
light-p-1643.html

Grove - RGB Backlit LCD

Setting up the SD card for the Raspberry Pi

Before you get started with the Grove Pi+, you need a working SD Card to use with the
Raspberry Pi.

A standard installation of “wheezy” or Raspbian will not work with the GrovePi; there
are some specific modifications that must be made to successfully operate the GrovePi.
We have listed some options below :

Option 1: Configure your own SD card image

Before beginning your Raspberry Pi must be connected to the internet.
Steps:
1). Clone the Github repository at an appropriate location
git clone https://github.com/DexterInd/GrovePi.git
2). Run the bash script in the Scripts folder to configure the Raspbian.

3). Change directory to the Scripts folder in the GrovePi folder.
cd GrovePi/Script

4). Make the install.sh bash script as executable. We do this by modifying the
permissions of the script:
sudo chmod +x install.sh

5). Start the script. You must be the root user, so be sure to include “sudo”.
sudo ./install.sh

6). Press “Enter” to start when you are prompted.

7). The script will download packages from the internet which are used by the
GrovePi+. Press “y” when the terminal prompts and asks for permission to start the
download.

8). Restart the Raspberry Pi:

sudo reboot




Option 2: Download our custom “Raspbian for Robots” image

If you want to download and use our modified “wheezy” image on a dedicated SD card
you can download it from the following locations:
(http://sourceforge.net/projects/dexterindustriesraspbianflavor)

You will need a minimum 4 GB card to install this image.

We highly recommend you visit the elinux.org website and read through their RPi Easy
SD Card Setup before installing an image here
(http://elinux.org/RPi_Easy_SD_Card_Setup).

Steps:
1). Download the latest image from Sourceforge:
(http://sourceforge.net/projects/dexterindustriesraspbianflavor/).

2). Download and install Win32Disklmager
(http://sourceforge.net/projects/win32diskimager/).

3). Unzip the image file you downloaded.

4). Install the image on your SD card. Be careful to select the SD Card Drive!! If
you select the wrong drive you can destroy your computer’s hard disk or
other information!

Note that you can expand to the full size of your SD Card by running the command
sudo raspi-config

And expanding the rootfs to use all available space on the SD Card. You can update
your configuration and hardware profiles by running:

sudo apt-get update

sudo apt-get upgrade
when connected to the internet.

Option 3: Use an SD card from Dexter Industries

If you purchased a Dexter Industries SD card for your GrovePi+
(http://www.dexterindustries.com/site/?product=sd-card-raspbian-wheezy-image-for-
raspberry-pi), you can skip this step: your SD card is already configured!
Note you can expand your Dexter Industries SD Card by running the command:

sudo raspi-config
You can buy the SD card from Dexter Industries
(http://www.dexterindustries.com/site/?product=sd-card-raspbian-wheezy-image-for-r
aspberry-pi).



Hardware connection for GrovePi+

Connecting the GrovePi+ to the Raspberry Pi

First, mount your GrovePi+ on the Raspberry Pi. The GrovePi+ slides over top of the
Raspberry Pi as shown in the picture below.

Raspberry Pi GrovePi+

Ensure that the pins are properly aligned when stacking the GrovePi+.

Powering up the Raspberry Pi

To power the GrovePi+ and the Raspberry Pi, you can use the micro USB power port on
the Raspberry Pi.

Remember to use a good power adapter capable of supplying 1A at 5V and you should
be fine with the power.

If you want to run the GrovePi+ in a standalone configuration, then you might find a
USB power bank.




Access to GrovePi+

With some of your projects, hooking up a monitor and micro USB cable power supply
might be impractical. We have developed extra options to make network
configuration quick with the GrovePi+.

Here we explain the options we have worked into the GrovePi+ Image for Network
Configuration here and offer some hints on how to get started using the GrovePi+.

These are “run once” operations. To setup, you can make these changes, and you
should only have to make these changes once.

The last two options are for controlling your Raspberry Pi; once you have a connection
setup, you can use the Raspberry Pi command line or VNC to start programming.

Option 1: Access as Desktop

1. MicroSD Slot 2. HDMI and Audio output
3.4 USB2.0 ports 4. Ethernet port
5. Micro USB port, USB power port 6. GPIO ports

7.LED indicator
8.DSI/CSI, Camera Module and Display Module interface.

Using a monitor, mouse, keyboard: the bullet-proof option. The GrovePi+ case is
designed to allow space for a keyboard, monitor, and mouse.

You may find that you need a USB hub to add a WIFI device to the GrovePi. The
advantage of this configuration is that you don’t have to configure the WIFI on the
Raspberry Pi, or login remotely on the computer.

For more information on this, we recommend browsing the Raspberry Pi Foundations
Quickstart Guide here (http://www.raspberrypi.org/quick-start-guide).



Option 2: Access via E net Cable

The Dexter Industries SD card comes configured with Bonjour which allows you to get

the networking up and running with zero configuration.

@ If you are using Windows and don't have iTunes installed, download Bonjour from
here (http://support.apple.com/kb/dI999) and install it.

@ If you are on a Mac or already have iTunes installed skip this step.

@ If you are using your own image, just install avahi-daemon in you Raspbain image:
sudo apt-get update
sudo apt-get install libnss-mdns

Windows

Open Putty and enter the Host Name as raspberrypi.local and press open.
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This will open a terminal and ask for a Username and Password. The username is “pi”

and the password is “raspberry”. After entering the credentials, you'll get logged on to
the Raspberry Pi terminal.



Mac

You can log into your Raspberry Pi using Bash on your Mac.
Again, we'll open up a new terminal: Press “Command Space”, which opens Spotlight.

Type “Terminal” and the terminal will come to the top.

Click on the terminal icon. In Bash, type:
ssh pi@raspberrypi.local

You'll be prompted to verify you're trying to login to the Raspberry Pi.
Type “yes” and press return.

Type the password. The default password for the BrickPi image is “raspberry”. Type
“raspberry” and press return.

Boom! You're logged into your Raspberry Pi and ready to start programming the
GrovePi!

18086 T = ~—ssh—80x33 o
Last login: Wed Jul 16 15:44:10 on ttys000
109:~ heerakanboj$ ssh pigraspberrypi. local
The suthenticity of host *raspborrypi.local (169.254.8.213)" con't be estoblishe

REA key fingerprint s 74127:c6:a2115:0e:10:ca:3d:69:20: fezds:b6:d3:30.
Are you sure you want to continue connecting (yes/no)? y
Please type ve:
Warning: Permanently odded *raspberrypi. local, 169.254.8.213' (RSA) to the list o
£ known hosts.

pi€raspberrypi.local's passwol
T Fachberryps 3112505 $68 PREEHPT Fri May 30 16:39:11 BST 2014 armusl

The prograns included with the Debian GNU/Linux system are free software;
the exact distribution terms for each progran are described in th
individual files in /usr/share/doc/x/copyright.

Debian GNU/Linux cones with ABSOLUTELY NO WARRANTY, to the extent
permitted by applicable Lo

Last login: Thu Jun 12 10:32:34 2014 from dexter-probook-2.local
pleraspberiyst ~ 8 s

Desktop  ocr_pi.png  pyush  sketchbook usb_wifi.s
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Option 3: Access via WiFi

The most autonomous way to connect to your GrovePi+ is through a WiFi dongle.
The most reliable way to set the GrovePi+ up on your local WiFi network is to use
Option 1 or Option 2, and change your wifi setting on the Raspberry Pi.

You can setup WiFi on the GrovePi using the command line. Below are step-by-step
instructions and some troubleshooting tips for setting up WiFi on the GrovePi+.

1. A static IP

We DO NOT recommend that you use a static IP for wifi interface with the GrovePi+.
The latest version of the GrovePi+ Raspbian comes with Bonjour. In short, this means
that instead of using an IP address, you can connect using “raspberrypi.local”. The Pi
can be accessed over the network (via VNC or SSH) by any computer that has
Bonjour installed.

@ Mac: If you have a Mac, Bonjour is installed.

@ Linux: If you have a computer with iTunes installed, Bonjour is installed.

@ Windows: If you need to install Bonjour, you can find it on Apple’s website here
(http://support.apple.com/kb/DL999).

2. Insert Wifi Dongle

Boot the Raspberry Pi with the Wifi dongle plugged in, and open a terminal session
in the Raspberry Pi.

3. With the GUI

If you want to setup Wifi using the GUI, login to the Raspberry Pi.

3.1 Click on WiFi Config

The icon on the desktop labeled “WiFi Config”. Click on it. Change tabs to “Manage

Networks” and click “Scan”. Clicking “Scan” reveals the wifi networks available.
Click the network you want to connect to.

SSID © [Bssip |trequency  [signal |
Tata Docome... 00: | -238 dBm [I
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Binatone d8:5d:4c:ic5: 2462 -233 dBm [t
ASUS_Guestl 08:60:6e:bc:... 2462 247 dBm [
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3.2 Enter your wifi information
Enter in your wifi information and click “Add”. Your Raspberry Pi should connect
automatically to the WiFi network.

4. With the Command Line
If you want to setup wifi using the terminal or SSH, In the terminal, open your interfaces

file for editing with the following command:
sudo nano /etc/network/interfaces

4.1 Interfaces File
Your interfaces file should look like this:

pigraspberrypic

4.2 Edit the File
Edit the file by adding the network configuration information, and your network's SSID
and passphrase below the last line. Indent one tab!.

wpa-ssid "ssid"
wpa-psk "password"

pitiraspberrypi: -

Fle Edt Tabs Help
G o 7 2 6 FIle Jetcinateori interfaces




4.3 Test your Wifi Adapter

After adding your information, save and exit by typing “Ctrl-x” and choosing to save
the file. And then reboot your raspberry pi. After reboot success, test that your Pi
recognizes the WiFi Adapter. You can test by typing “ifconfig” in the terminal of the
GrovePi+. If “wlan0” is showing, the wifi dongle is recognized.

5. Check for a Connection
Check that you are successfully connected to the network. In the command line, type:
ifconfig

When RX and TX are showing 0 bytes, no data has been exchanged. Below is a
successfully connected Raspberry Pi to a wifi network.

/pi

You have successfully setup the network on the Raspberry Pi.




Running Examples of GrovePi+

Here we have a list of example projects that show just how easy it is to start a project
with the GrovePi+. These GrovePi projects combine easy-to-use Grove sensors with the
powerful Raspberry Pi.

Example Project: LED Blink

This tutorial shows the simplest thing that you can do with the GrovePi: Blink a LED.
This is a great first project to learn how to connect hardware to the Raspberry Pi.
The blinking LED is the hardware version of the software world’s “Hello World”
program.

Once mastered, you can move on to more complicated projects like connecting a
display or other sensors to the Raspberry Pi. This example is meant to be your first
project with the GrovePi+. All the parts used in this project are available in the GrovePi+
Starter Kit.

Hardware for This Tutorial
All of the hardware comes with the GrovePi+ starter kit. Specifically, for the Raspberry
Pi LED Tutorial, you'll need:

=l
GrovePi+ Raspberry Pi

=

Grove Connection wire Grove LED




Hardware Setup: Connecting the LED to the Raspberry Pi
Connect the LED to Port D4 and power on the Raspberry Pi, using the Grove wire
connector.

Running the Program
The example program for this project is shown below. To run the program, change
directory on your Raspberry Pito the GrovePi+/Software/Python folder.
cd /GrovePi/Softwave/Python
Run the grove_led_blink.py python program:
sudo python grove_led_blink.py
The Grove LED will start blinking.

Source Code

The source code for the example can be found here:
https://github.com/Dexterlnd/GrovePi/blob/master/Software/Python/grove_led_
blink.py

# GrovePi LED Blink example
# http://www.seeedstudio.com/wiki/Grove_-_LED_Socket_Kit

import time
from grovepi import *

# Connect the Grove LED to digital port D4
led = 4

pinMode(led, "OUTPUT")
time.sleep(1)
while True:
try:
#Blink the LED
digitalWrite(led,1) # Send HIGH to switch on LED
time.sleep(1)

digitalWrite(led,0) # Send LOW to switch off LED
time.sleep(1)

except KeyboardInterrupt: # Turn LED off before stopping
digitalWrite(led,0)
break

except IOError: # Print "Error" if communication error encountered
print "Error"

Outcome
This project is very straightforward: you should see the LED blink on and off ata 1
second interval.



Example Project: LED Fade

This project shows how to fade an led with the Raspberry Pi.

A rotary angle sensor (a fancy name for a potentiometer) is used to get the analog
values and the Raspberry Pi sends commands to the Grove Pi to set the LED's intensity.
Setting Up The Hardware

Simply plug the LED Module in Port D5 and the Rotary encoder in Port A0. That's it.

GrovePi+ Raspberry Pi

@
E ==

Grove -

Rotary Angle Sensor

Grove Connection wire

Running the Program
The example program for this project is shown below. To run the program, change
directory on your Raspberry Pito the GrovePi+/Projects/LED fade folder.

cd /GrovePi/Projects/LED_Fade
Run the led_fade.py python program:
sudo python led_fade.py

Source Code
Below is the code for running this example. You can access the code here:
https://github.com/Dexterlnd/GrovePi/blob/master/Projects/LED%20Fade/led_fade.py




# Adjust LED brightness by rotating Potentiometer

# GrovePi + Rotary Angle Sensor (Potentiometer) + LED
# http://www.seeedstudio.com/wiki/Grove_-_Rotary_Angle_Sensor
# http://www.seeedstudio.com/wiki/Grove_-_LED_Socket_Kit

import time
import grovepi

# Connect the Rotary Angle Sensor to analog port A2
potentiometer = 2

# Connect the LED to digital port D5
led = 5

grovepti.pinMode(led,"OUTPUT")
time.sleep(1)

i=0
while True:
try:

# Read resistance from Potentiometer
i = grovepi.analogRead(potentiometer)
print i

# Send PWM signal to LED
grovepi.analogWrite(led,1/4)

except IOError:
print "Error"

Outcome

This project, like the previous project, has a straightforward outcome: as you turn the
potentiometer back and forth, you should see the LED increase and decrease in
strength. In your Raspberry Pi terminal, you will see a number printing, which
represents the position of the potentiometer.




Example Project: Button And Buzzer

In this project, we connect a Grove Button and a Buzzer to the Raspberry Pi.

Setting Up The Hardware
Simply plug the Buzzer Module to Port D2, the Rotary to Port AQ. That's it.

GrovePi+ Raspberry Pi
hr s
3 el H -
Grove Button Grove Buzzer

Running the Program
The example program for this project is shown below. To run the program, change
directory on your Raspberry Pito the GrovePi/Projects/LED fade folder.

cd /GrovePi/Projects/Button_And_Buzzer

Run the grove_led_blink.py python program:
sudo python Button_And_Buzzer.py

Source Code

The source code for the example can be found here:
https://github.com/Dexterlnd/GrovePi/blob/master/Projects/Button_And_Buzzer/Butt
on_And_Buzzer.py




# button_buzzer.py

#

# This is an project using the Grove Button, Buzzer from the GrovePi starter kit
#

# In this project, the buzzer starts making a sound when the the button is hold
import time

from grovepi import *

import math

buzzer_pin = 2 #Port for buzzer
button = 4 #Port for Button
pinMode(buzzer_pin,"OUTPUT") # Assign mode for buzzer as output
pinMode(button,"INPUT") # Assign mode for Button as input
while True:

try:

button_status= digitalRead(button) #Read the Button status
if button_status: #If the Button is in HIGH position, run the program
digitalWrite(buzzer_pin,1)
# print "\tBuzzing"
else: #If Button is in Off position, print "Off" on the screen
digitalWrite(buzzer_pin,0)
# print "Off"
except KeyboardInterrupt: # Stop the buzzer before stopping
digitalWrite(buzzer_pin,0)
break
except (IOError,TypeError) as e:
print "Error"

Outcome
The outcome of this project will show up on the Raspbery Pi terminal, and with the
sound of the buzzer making noise.




Example Project: Ultrasonic And Relay

In this project, we connect a Grove Ultrasonic and a Relay to the Raspberry Pi.

You can use this project to detect distance of any object in the front of your machine, it
can be a counterguard robot or a auto-open door.

Setting Up The Hardware
Simply plug the Buzzer Module to PortD2, the Rotary to PortA0. That's it.

GrovePi+ Raspberry Pi

Grove Relay Grove Ultrasonic

Running the Program
The example program for this project is shown below. To run the program, change
directory on your Raspberry Pito the GrovePi/Projects/LED fade folder.

cd /GrovePi/Projects/Ultrasonic_And_Relay

Run the grove_led_blink.py python program:
sudo python Ultrasonic_And_Relay.py

Source Code

The source code for the example can be found here: https://github.com/Dexterlnd/Grove-
Pi/blob/master/Projects/Ultrasonic_And_Relay/Ultrasonic_And_

Relay.py




GrovePi + Grove Ultrasonic Ranger
http://www.seeedstudio.com/wiki/Grove_-_Ultrasonic_Ranger

kit
In this project, the ultrasonic can figure out the distance of object in front,

#
#
# This is an project using the Grove Ultrasonic Ranger and Relay from GrovePi start
#
#
# when object close to it within 10cm, the relay will turn on

from grovepi import *

# Connect the Grove Ultrasonic Ranger to digital port D4
# SIG,NC,VCC,GND

ultrasonic_ranger = 4
Relay_pin = 2

pinMode(Relay_pin,"OUTPUT")

while True:
try:
# Read distance value from Ultrasonic
distant = ultrasonicRead(ultrasonic_ranger)
print distant,'cm’
if distant <= 10:
digitalWrite(Relay_pin,1)
else:
digitalWrite(Relay_pin,0)

except TypeError:
print "Error"

except IOError:
print "Error"

Outcome

The outcome of this project will show up on the Raspbery Pi terminal, and you can put
your hand close to the ultrasonic to see, will the relay turn on within about 10cm and
turn off without about 10cm.




Example Project: Home Weather Display

In this project, we use a Grove DHT (Digital Humidity and Temperature) sensor as a
Raspberry Pi temperature sensor. This project uses a Grove RGB LCD display,
connected to the Raspberry Pi, to show the temperature and humidity. You can use
this project as designed: a simple weather station for your home.

Connecting the Raspberry Pi temperature sensor
Connect the DHT sensor to Port 7 and the RGB LCD display to any of the 12C ports. Now
power on the Raspberry Pi.

GrovePi+ Raspberry Pi

Grove DHT sensor  Grove RGB LCD Display

Running the Program
Run the home_temp_hum_display program:

sudo python GrovePi_LCD_DHT.py

Source Code

The source code for the example can be found here:
https://github.com/Dexterind/GrovePi/blob/master/Projects/Home_Weather_Display/Home_
Weather_Display.py




# grovepi_lcd_dht.py

#

# This is an project for using the Grove OLED Display and the Grove DHT Sensor from
# the GrovePi starter kit

# In this project, the Temperature and humidity from the DHT sensor is printed on
the DHT sensor

from grovepi import *
from grove_rgb_lcd import *

dht_sensor_port = 7 # Connect the DHt sensor to port 7

while True:
try:
[ temp,hum ] = dht(dht_sensor_port,1) #Get the temperature
#and Humidity from the DHT sensor
print "temp =", temp, "C\thumadity =", hum,"%"
t = str(temp)
h = str(hum)

setRGB(0,128,64)
setRGB(0,255,0)

setText("Temp:" + t + "C " + "Humidity :" + h + "%")

except (IOError,TypeError) as e:
print "Error"

Outcome

The outcome of the project should show up on your Raspberry Pi and the screen.
Below you can see the temperature printed on the Raspberry Pi terminal. Further
down, you can see the same information printed on the attached display.The LCD
display will start showing the live temperature data and humidity data from the DHT

sensor.




Example Project: Sensor Twitter Feed

In this example we tweet the temperature, light, and sound levels with our Raspberry
Pi. The data is taken by the GrovePi and pushed to our Twitter feed with the Raspberry
Pi.

Hardware Setup

This example uses a sound sensor, a light sensor, and temperature sensor connected
with the GrovePi’s Analog Ports(Port A2,A1 and AO respectively). An LED connected to
a PWM channel (Port D3) and responds to light conditions.

Grove DHT sensor Grove LED

Grove Light sensor ~ Grove Sound sensor

Running the Program
In the Raspberry Pi terminal, change directory to GrovePi/Projects/Sensor Twitter Feed:
cd /GrovePi/Projects/Sensor Twitter Feed

In the directory, Run the wifi_twit.py:
sudo python wifi_twit.py



Source Code
The source code for the example can be found here:
https://github.com/Dexterind/GrovePi/blob/master/Projects/Sensor%20Twitter%20Feed/wifi_twit.py

*

Tweet the temperature, light, and sound levels with our Raspberry Pi
http://dexterindustries.com/GrovePi/projects-for-the-raspberry-pi/sensor-twitter
-feed/

*

# GrovePi + Sound Sensor + Light Sensor + Temperature Sensor + LED
# http://www.seeedstudio.com/wiki/Grove_-_Sound_Sensor
# http://www.seeedstudio.com/wiki/Grove_-_Light_Sensor_v1.2
# http://www.seeedstudio.com/wiki/Grove_-_Temperature_and_Humidity_Sensor_Pro
# http://www.seeedstudio.com/wiki/Grove_-_LED_Socket_Kit

import twitter

import time

import grovepi

import math

# Connections

sound_sensor = 0 # port A0
light_sensor = 1 # port Al
temperature_sensor = 4 # port D4
led = 3 # port D3

# Connect to Twitter

apil = twitter.Api(consumer_key='YourKey',consumer_secret='YourKey',access_token_
key="'YourKey',access_token_secret="'YourKey"')

print "Twitter Connected"

grovepi.pinMode(led, "OUTPUT")
last_sound = 0

while True:
# Error handling in case of problems communicating with the GrovePi
try:
# Get value from temperature sensor
[temp,humidity] = grovepi.dht(temperature_sensor,1)
t=temp

# Get value from light sensor
light_intensity = grovepi.analogRead(light_sensor)

# Give PWM output to LED
grovepi.analogWrite(led,light_intensity/4)

# Get sound level
sound_level = grovepi.analogRead(sound_sensor)
if sound_level > 0:

last_sound = sound_level




# Post a tweet

print ("DI Lab's Temp: %.2f, Light: %d, Sound: %d" %(t,light_intensity/

10,last_sound))

api.PostUpdate("DI Lab's Temp: %.2f, Light: %d, Sound: %d" %(t,light_

intensity/10,last_sound))
time.sleep(3)
except IOError:
print "Error"
except:
print "Duplicate Tweet"

Outcome

You should see two outcomes. The first is output on your terminal screen, shown
below. You should see “Twitter Connected” if the connection is made succesfully. Then

a series of Temperature, Light, and Sound values.

You should also see your Twitter stream start to update. It might take a few minutes for

Twitter to update.

DexterindustriesLab

@DexterindLab

24 [} o =

Tweets

DexterindustriesLab
DI Lab's Temp: 24.26, Light: 78, Sound: 141
DexterindustriesLab
DI Lab's Temp: 24 35, Light: 75, Sound: 141
DexterindustriesLab
DI Lab's Temp: 24.43, Light: 75, Sound: 141

Edit profile
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1. Set up your PC

1.1 Download Windows 10 and Install Visual Studio 2015

To set up your Windows 10 loT Core development PC, you first need to install the
following:

® Make sure you are running the public release of Windows 10 (version 10.0.10240)
or Newer. You can upgrade from http://www.microsoft.com/en-us/software-down-
load/windows10. If you are already running Windows 10, you can find your current
build number by clicking the start button, typing “winver”, and hitting enter.

@ Install Visual Studio 2015

a. We recommend Visual Studio Community Edition, but Visual Studio Professional
2015 and Visual Studio Enterprise 2015 will work as well
(available https://www.visualstudio.com/vs-2015-product-editions).

b. If you have to install Visual Studio, make sure to do a Custom install and select the
checkbox Universal Windows App Development Tools -> Tools and Windows SDK.

c. If you already have Visual Studio, you will be prompted to download the needed
tools when attempting to run our solution in the next part of the tutorial.

@ Install Windows loT Core Project Templates from
https://visualstudiogallery.msdn.microsof.com/06507e74-41cf-47b2-b7fe-
8a2624202d36.

Alternatively, the templates can be found by searching for Windows loT Core Project
Templates in the Visual Studio Gallery or directly from Visual Studio in the Extension
and Updates dialog (Tools > Extensions and Updates > Online).

® Enable developer mode on your Windows 10 device by following https://msdn.mic-
rosoft.com/library/windows/apps/xaml/dn706236.aspx. The relevant portion of the
linked instructions is the “Windows 10 Desktops/tablets” section, as you should be
attempting setup with one of these devices.

Open Visual Studio 2015 and create a Universal Windows Platform (UWP) App by
selecting ‘File > New > Project > Visual C# > Windows > Universal > Blank App
(Universal Windows)'. This is required to ensure that the framework dependencies are
available for our samples to build.




2. Set up your Raspberry Pi

Before you get started with the GrovePi +, you need a SD Card which is running the
win10 for loT core.

2.1 What you need

® A PCrunning Windows 10 - as prepared in the previous steps

® Raspberry Pi 2
http://www.seeedstudio.com/depot/Raspberry-Pi-2-Moel-B-w-ARMv7-Quad-
Core-1GB-RAM-p-2289.html?cPath=122_154_159

® 5V Micro USB power supply - with at least 1.0A current. If you plan on using several
power-hungry USB peripherals, use a higher current power supply instead (>2.0A)

® 8GB micro SD card - class 10 or better.

® HDMI cable and monitor

® Ethernet cable

® Micro SD card reader - due to an issue with most internal SD card readers

@ Install the Windows 10 loT Core tools

You can also buy Quick Starter Kit for Raspberry Pi 2 Model B from
http://www.seeedstudio.com/depot/Quick-Starter-Kit-for-Rasp-
berry-Pi-2-Model-B-p-2364.htmI?cPath=122_154_151, itinclude:

1x 8GB SD card preinstalled Raspbian OS
1x Raspberry Pi Black Enclosure

1x 5V 2.1A USB Power Adapter

1x Micro USB Cable with Switch

1x HDMI Cable - 3.2"(1 meter)

1x USB to TTL Serial Cable

1x Ethernet Cable - 3.2"(1 meter)

1x 802.11b/g/n Wireless USB Adapter




2.2 Install the Windows 10 loT Core tools

® Download a Windows 10 IoT Core image from the
http://ms-iot.github.io/content/en-US/Downloads.htm. Save the ISO to a local folder.

2| 10T Core RPi 6/18/2015 %19 AM  Disc Image File 473,422 KB

® Double click on the ISO (IoT Core RPi.iso). It will automatically mount itself as a virtual
drive so you can access the contents.

This PC » DVD Drive (H:) _ARPI_A32FREQ_EN-US_DV3

-

MName Date modified Type Size

8 Windows 10 loT Core RPi2 6/17/2015 2204 PM  Windows Installer ... 472,800 KB

® [nstall Windows_10_loT_Core_RPi2.msi. When installation is complete, flash.ffu will
be located at C:\Program Files (x86)\Microsoft loT\FFU\RaspberryPi2.

This PC » 05Disk (C:) » Program Files (x86) » Microsoft loT » FFU » RaspberryPi2

-

Name Date modified Type Size

D flash.ffu 6/19/2015 3:52 PM FFU File 1,204,224 KB

® Eject the Virtual CD when installation is complete - this can be done by navigating
to the top folder of File Explorer, right clicking on the virtual drive, and selecting “Eject”.




2.3 Put the Windows 10 lo

@ Insert a micro SD card into your SD card reader.
® Use loTCorelmageHelper.exe to flash the SD card. Search for “WindowsloT” from start
menu and select the shortcut “WindowsloTImageHelper”.

WindowsloTimageHelper
Desktop 3y
WindowsloTCoreWatcher

Desktop app
Web
£ windows iot

windows iot core
P wind
‘windows iot raspberry pi
P wind ber
‘windows iot core watcher
P windows iot tehe
‘windows iot core downloa
R windows iot core download
P windows iot core watcher utility
P windows iot gui

P windows iot pwm

S8 My stuff £ web

windowsiof

® The tool will enumerate devices as shown. Select the SD card you want to flash, and
then provide the location of the ffu to flash the image.

0 Windows T Core mageHelpar - o x

Put loT Core onto your SD card

Select the SD card

146D [Generic- SD/MMC USB Device]

Select the image (ffu)




NOTE: loTCorelmageHelper.exe is the recommended tool to flash the SD card. However,
instructions are available for using DISM command line tool directly.

@ Safely remove your USB SD card reader by clicking on “Safely Remove Hardware” in
your task tray, or by finding the USB device in File Explorer, right clicking, and choosing
“Eject”. Failing to do this can cause corruption of the image.

2.4 Hook up your board

1. Insert the micro SD card you prepared into your Raspberry Pi 2 (the slot is indicated
by arrow #1 in the image below).

2. Connect a network cable from your local network to the Ethernet port on the
board. Make sure your development PC is on the same network.

3. Connect an HDMI monitor to the HDMI port on the board.

4. Connect the power supply to the micro USB port on the board.




2.5 Boot Windows 10 loT Core

® Windows 10 loT Core will boot automatically after connecting the power supply. This
process will take a few minutes. After seeing the Windows logo, your screen may go
black for about a minute - don’t worry, this is normal for boot up. You may also see a
screen prompting you to choose a language for your Windows 10 loT Core device -
either connect a mouse and choose your option, or wait about a 1-2 minutes for the
screen to disappear.

® Once the device has booted, the DefaultApp will launch and display the IP address of
your RPi2.

Devies name

Network

P address

@ Follow the PowerShell documentation
http://ms-iot.github.io/content/en-US/win10/samples/PowerShell.htm to use
PowerShell to connect to your running device. You can also follow the instructions
http://ms-iot.github.io/content/en-US/win10/samples/SSH.htm to use SSH to connect
to your device.

@ Itis highly recommended that you update the default password for the Administra-
tor account. To do this, issue the following commands in your PowerShell connection:
® Replace [new password] with a strong password:

net user Administrator [new password]

Once this is done, you'll need to re-establish the current session using enable-psSession
with the new credentials.



3. Hardware connection for GrovePi+

3.1 Connecting the GrovePi+ to the Raspberry Pi

First, mount your GrovePi+ on the Raspberry Pi. The GrovePi+ slides over top of the
Raspberry Pi as shown in the picture below.

Raspberry Pi GrovePi+

Ensure that the pins are properly aligned when stacking the GrovePi+.

3.2 Powering up the Raspberry Pi

To power the GrovePi+ and the Raspberry Pi, you can use the micro USB power port on
the Raspberry Pi.

Remember to use a good power adapter capable of supplying 1A at 5V. If you want to
run the GrovePi+ in a standalone configuration, then you might find a USB power bank.




4. Install GrovePi C# library for Raspberry Pi

The GrovePi can be programed in C#, but first you should install the Windows 10 loT C#
driver library for GrovePi, There're two ways to do this.

All supported sensors are available through the DeviceFactory class.
Supported sensors include:

Grove - Relay

Grove - Led

Grove - Temperature&Humidity Sensor

Grove - Ultrasonic Sensor

Grove - Accelerometer Sensor

Grove - Real Time Clock

Grove - Build Led Bar

Grove - Four Digit Display

Grove - Chainable RGB LED

Grove - Rotary Angle Sensor

Grove - Buzzer

Grove - Sound Sensor

Grove - Light Sensor

Grove - Button

Grove - RGB LCD Display

Examples

Below are some simple examples of how to use the library.
® Measure Distance
Ultrasonic sensor plugged into digital pin 2 (D2)
var distance = DeviceFactory.Build.UltraSonicSensor(Pin.DigitalPin2).Measure-
InCentimeters();
® Display Hello World
DeviceFactory.Build.RgbLcdDisplay().SetText("Hello World").SetBacklightRgb(0, 255,
255);
® Sound the buzzer
Sound the buzzer plugged into digital pin 2 (D2).
DeviceFactory.Build.Buzzer(Pin.DigitalPin2).ChangeState(SensorStatus.On);




4.1 Install the NuGet package

The GrovePi NuGet package for the current release is available. More details

https://www.nuget.org/packages/GrovePi/.

To install GrovePi for Windows loT follow the following steps.

® Step1: From the Tools menu, select Library Package Manager and then click Package
Manager Console.

Tools | Avchitecture  Test Analyze Window
Check Accessibility...

Attach to Pracess.., Cil+Alt+P
Connect to Datahase..,

Connectta Server...

Add SharePaint Connection. .

[l e

Code Snippets Manager.. Chrl+K, Cul+B
Choose Toolbox Iterms..

Add-in Manager..

Library Package Manager »
Macros 4 dd Library Package Reference
Extension Manager... W% Package Manager Settings

-

Install Web Components
Dotfuscator Software Services
Create GLID

Error Laokup

&

W/CF Service Configuration Editor
External Tools..

Import and Export Settings...
Custamize...

Optians...

The Package Manager Console window is displayed.

Thpe get-nelo mset to see 311 avatiable et comands

® Step2: Run the following command in the Package Manager Console.
PM> Install-Package GrovePi




4.2 Use the GrovePi C# library code

If you're a senior programmer or you can't install the GrovePi NuGet package
successfully, you can download the library code by click this
https://github.com/Dexterlnd/GrovePi/tree/master/Software/CSharp.

® Step1: Move the two C# library projects “GrovePi” and “Driver” to the folder where
your project resides. And add them to your project in Solution Explorer.

For example, right click the Solution “GrovePiExamples ”, Add | Existing Project, as
below shows.

<1 Loclbictine < |

LEEEN

% Buid Solution
Rebuit Solution
Depioy Souion
Clean Solation
Ron Code Anslysson Slution
Batch B,

Al

Configurtion Mange..
Manage NuGet Packages fo Sotion.
Restore NuGe Packages
NewSoluon ExlorerView
Colcuste Code Metr:

NewProect.

Eisting Pojct.

a4 B
Set Stalp Projcts..

New Wb Ste. Add Souton o Source Control.. 5
 Newhem. Cuesnin Paste v

rewsised | 4 Ging tem.. ShiteAkeA [
% New Soluton Folder

Properts

e
" " Prr—— :
Then add “GrovePi” and “Driver” to the Solution Explorer.
©q Add Bxisting Project X
<« . <« GrovePi > GrovePi v o Search GrovePi Vel
Organize v New folder B M @
+ Quickacces Nome Detemodiied | Type
bin 1071020153230 File folder
o4 Microsoft Visual S
Common 10102015 3230 File folder
Projects 12CDevices File folder
& OneDrive obj File folder
broperis File folder
5 This C Sensors. 10/10/2015 3:23PM  File folder
I Desktop. [ GrovePicsproj 10/9/2015342 PV Visual C Project .
Documents T projectjson 10/9/2015342PM  ISON File
§ Downloads
D Music
i) Pictures.
B Videos M 5
File name: | GrovePi.csproj wbpn ~




® Step2: Set the C# library as the reference projects.
Right click References and click Add References

M Properties
1 Beferences

oD
[

=
3

Add Reference...

Add Service Reference...
Add Connected Service...
Add Analyzer...

Manage MuGet Packages...
Scope to This

Mew Solution Explorer View

Click Projects | Solution, and check box as shown in the red box below. Then click OK.

Reference Manager - Blink 7

b Assemblies Search Projects (Ctri+B) P -

4 Projects == Path e

Driver CAUsers\lidre\Desktop\G  Dfiver
— GrovePi CAUsers\idre\Deskiop\G

v )

b Universal Windows

b Browse

‘ »

i

Now, you have already install the GrovePi C# library successfully.




5. Running Examples of GrovePi+ on Win10 for loT core

Here we have a list of example projects that show just how easy it is to start a project
with the Raspberry Pi. These Raspberry Pi projects combine easy-to-use Grove sensors
with the powerful Raspberry Pi.

You can click https://github.com/Seeed-Studio/GrovePiExamples_win10 to download
the GrovePi Example code for win10.

5.1 Blink

Once mastered, you can move on to more complicated projects like connecting a
display or other sensors to the Raspberry Pi. This example is meant to be your first
project with the GrovePi+. All the parts used in this project are available in the GrovePi+
Starter Kit.
Take the Blink project as an example.
® Step1: Open the GrovePiExamples(win10).sIn.
® Step2: Set the Blink project as StartUp Project.

Right click the Blink project in the Solution Explorer, and click Set as StartUp Project

[3] Solution 'GrovePiExamples{win10) (4 projects)
&I Blink (Universal Windows)

& Build & Properties
Rebuild 8 References
Deploy Assets
1 Appaxaml
= {1 Applicationinsights.config
View * | B Blink_TemporaryKey.pfx
Analyze » | D) MainPageaxaml
*?  Configure Application Insights... B Package.appxmanifest
& projectjson
SEES ) Driver (Universal Windows)
B New Solution Explorer View £] GrovePi (Universal Windows)
Build Dependencies , £ HelloWorld(LCD) (Universal Windows)
Add »
Store ’
B Manage NuGet Packages.
£ Setas StartUp Project
Debug »
Source Control »
3 Cut Ctrl+X
Paste Ctrl+V
X Remove Del
Rename

Unload Project

€ Open Folder in File Explorer

Design in Blend...
n Explorer
A Properties Alt+Enter




@ Step3: Click Build | Configuration Manager. Check the box as below shows.

Configuration Manager ? X
r
Active solution configuration: Active solution platform: u
Debug v| |arm o
i
Project contexts (check the project configurations to build or deploy): i
Project Configuration Platform Build Deploy
Blink Debug ARM
| | Driver Debug ARM
GrovePi Debug ARM
HelloWerld(LCD) Debug ~| ARM ~

@ Step4: Hardware connection.
All of the hardware comes with the GrovePi+ starter kit. Specially, for the Raspberry Pi
LED Blink, you'll need:

GrovePi+

Grove Connection wire Grove LED




Then connect the LED to Port D4 and power on the Raspberry Pi using the Grove wire

connector.

® Step5: Deploy your app.

a) With the application open in Visual Studio, set the architecture in the toolbar
dropdown. Select ARM.

b) Next, in the Visual Studio toolbar, click on the Local Machine dropdown and select
Remote Machine.

Debug -~ 86 </ P LocalMachine - | g _ i B | = %= | A
Simulator
All rights reserved. v Local Machine

Remote Machine

Device
5 Mabile Emulator 10.0.10240.0 WVGA 4 inch 512MB
o= Mobile Emulator 10.0.10240.0 WVGA 4 inch 1GB

ols.Primitives;

H Mobile Emulator 10.0.10240.0 WXGA 4.5 inch 1GB
Mobile Emulater 10.0.10240.0 720p 5 inch 1GB
Mohbile Frulator 10.0.10240.0 10800 & inch 2GR

c) At this point, Visual Studio will present the Remote Connections dialog. If you
previously used PowerShell to set a unique name for your device, you can enter it
here (in this example, we're using my-device). Otherwise, use the IP address of your
Windows loT Core device. After entering the device name/IP select None for
Windows Authentication, then click Select.

Remote Connections ? *
Filter P -
Found 26 connections

@ Manual Configuration

Address: my-device

Authentication Mode:  None b

Select




d) You can verify or modify these values by navigating to the project properties (select
Properties in the Solution Explorer) and choosing the Debug tab on the left:

Application

Configuration: | Active (Debug) v Platform: |Active (x86) v
Build
Build Events Start actian

[ Do not launch, but debug my code when it starts

Reference Paths Allew local network loopback

Signing Start options
Code Analysis Target device: Remote Machine >
Forz mosits [my-device Find...

[] Use suthentication
[] Uninstall and then re-install my package. All information about the application state is deleted

Debuggertype

Application process: Managed Only v

When everything is set up, you should be able to press F5 from Visual Studio. If there
are any missing packages that you did not install during setup, Visual Studio may
prompt you to acquire those now. The Blink app will deploy and start on the Windows
loT device, and you should see the LED blink.




5.2 Hello World from RGB LCD

This example is the same use as Blink.

® Step1: Open the GrovePiExamples(win10).sIn.

® Step2: Set the HelloWorld(win10) project as StartUp Project.

® Step3: Click Build | Configuration Manager. Check the box as below shows.

T 3 e V
Blink ARM a a
Driver ARM a
GrovePi ARM

[HelloWorld(LCD) v | ARM ~

® Step4: Hardware connection.

Connect the RGB LCD to Port 12C and power on the Raspberry Pi using the Grove wire
connector.

GrovePi+ Raspberry Pi

Grove RGB LCD Display

® Step5: Deploy your app. Refer to the Blink example of Step5.

When everything is set up, you should be able to press F5 from Visual Studio. If there
are any missing packages that you did not install during setup, Visual Studio may
prompt you to acquire those now.

The HelloWorld app will deploy and start on the Windows loT device, and you will see
the HelloWorld form the Grove RGB LCD.




5.3 Button and Buzzer

This example is the same use as Blink.

® Step1: Open the GrovePiExamples(win10).sIn.

® Step2: Set the ButtonAndBuzzer project as StartUp Project.

® Step3: Click Build | Configuration Manager. Check the box as below shows.

Biink Debug ARM =] 5]
ButtonAndBuzzer Debug ARM a
Driver Debug ARM a 5]
GrovePi Debug ARM o

HelloWorld(LCD) Debug v | ARM £ [m} [m}

® Step4: Hardware connection.
Connect the Grove Buzzer to Port D2, Grove Button to Port D4 using the Grove wire
connector, and power on the Raspberry Pi.

GrovePi+ Raspberry Pi
b o=
dl b b
JE! @
Grove Button Grove Buzzer

® Step5: Deploy your app. Refer to the Blink example of Step5.

When everything is set up, you should be able to press F5 from Visual Studio. If there
are any missing packages that you did not install during setup, Visual Studio may
prompt you to acquire those now.

The BuzzerAndButton app will deploy and start on the Windows loT device, and you

press the Grove Button the Grove Buzzer will ring. “



5.4 Home Weather Display

This example is the same use as Blink.

® Step1: Open the GrovePiExamples(win10).sIn.

® Step2: Set the HomeWeatherDisplay project as StartUp Project.

® Step3: Click Build | Configuration Manager. Check the box as below shows.

Configuration Manager 7 x
Active soluion confguraion: Activescltion petform:
Debug <] [arm =
Projct contents check the prject confi i ordeploy:
Project Plattorm Suid Depoy
Bink ARM o o

| Debug v | ARM ~ [w] [m
Drver Debug Y E] &]
Grovepi Debug ARM a
HelloWorld(LCD) Debug ARM [m) o
HomelWestherDispay Debug ARM =2

® Step4: Hardware connection.

Connect the Grove Temperature Sensor to Port A1, RGB LCD to Port I2C using the Grove
wire connector, and power on the Raspberry Pi.

GrovePi+ Raspberry Pi

Grove DHT sensor  Grove RGB LCD Display

® Step5: Deploy your app. Refer to the Blink example of Step5.

When everything is set up, you should be able to press F5 from Visual Studio. If there
are any missing packages that you did not install during setup, Visual Studio may
prompt you to acquire those now.

The Home Weather Display app will deploy and start on the Windows loT device, and
you can view the info. by the RGB LCD.



@ Windows Dev Center
https://dev.windows.com/en-us/iot

® GrovePi C# Library Code
https://github.com/Dexterlnd/GrovePi/tree/master/Software/CSharp

® Example Code
https://github.com/Seeed-Studio/GrovePiExamples_win10




FAQ's, Troubleshooting & Getting Help

Q. What languages are supported by GrovePi+?

We officially support C, Python, C# and Scratch, but there is no reason why it should not
run in any other language. There are people trying to make it work with Go and Node.js
and we have the code up on the Github repository (https://github.com/Dexter-
Ind/GrovePi/tree/master/Software).

We'll love to support more languages. If you are interested in porting the GrovePi+ to
other language we’'ll love to hear more from you.

Q. Which port on GrovePi+ does what?
Please check out the port description here: http://www.dexterindustries.com/Grove-
Pi/engineering/port-description/.

Q. How are the ports connected and where is the schematic?

Please check the GrovePi Schematic. GrovePi is open source and you can check out the
hardware files here:

https://github.com/Dexterlnd/GrovePi/tree/master/Hardware. You can open them in
Eagle or if you just want to take a look at the schematic, it’s available in PDF too.

Q. Would my sensor work with the GrovePi+?

Please check the supported sensors page here: http://www.dexterindus-
tries.com/GrovePi/sensors/supported-sensors/ to see if your sensor is officially
supported. If it is not just the next question should help you figure out how to get it to
work with the GrovePi+.

Q. ljust got a Grove sensor | can’t get get it to work with the GrovePi+.
First check if your sensor is officially supported by GrovePi+ here: http://www.dexterin-
dustries.com/GrovePi/sensors/supported-sensors/.

If it is then you might need a software and firmware update, here’s the guide:
http://www.dexterindustries.com/GrovePi/get-start-
ed-with-the-grovepi/updating-firmware/ .

Forum

If you have any other problems or suggestions post them on our forum: http://www.-
dexterindustries.com/forum/?forum=grovepi .
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For more information, please visit

seeed.cc/grovepi-kit

http://www.seeed.cc

http://www.dexterindustries.com



